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1 Sådan logger du på med din TI-konto

Sådan logger du på med din TI-konto
Hvis du vil bruge TI-SmartView™-emulatorsoftwaren til MathPrint™-lommeregnere,
skal du logge ind på din TI-konto.

1. Start TI-SmartView™-emulatorsoftwaren til MathPrint™-lommeregnere.

Hvis det er første gang, softwaren startes, vil du blive bedt om at acceptere
licensen, politikken om beskyttelse af personlige oplysninger og
onlinebrugsbetingelserne.

Klik på Accept.

2. I indlogningsskærmbilledet skal du klikke på LAUNCH SIGN IN.

Bemærk: Hvis du skal købe en enkeltbrugerlicens, skal du klikke på PURCHASE
LICENSE.

Hermed åbnes indlogningssiden for Texas Instruments i din browser. Gennemfør
indlogningsprocessen med en Google-konto eller med den e-mailadresse, der hører
til din TI-konto.



Når du har valideret din konto, vises der en gennemførelsesmeddelelse i
browseren, og softwaren åbnes.

Visning af licenseringsoplysninger

Mens du er logget ind, kan du se oplysningerne om din licens.

▶ Gå til Help > License Info.

Kontooplysninger: E-mailadresse på den aktuelle bruger.

Udløbsdato: Udløbsdato for den aktuelle softwarelicens.

Session Expiration: Resterende tid i den aktuelle session.

Mens softwaren bruges, opretter den forbindelse til licenseringssystemet hvert 15.
minut. Hvis brugeren går offline på noget tidspunkt, vil softwaren køre i syv dage
fra sidste gang, den oprettede forbindelse.

Sådan logger du ud af din konto

1. Gå til Help > Sign Out.

2. Klik på SIGN OUT.

Softwaren vil lukke, og der åbnes en browserfane på indlogningssiden.
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3 Sådan logger du på med din TI-konto

Hvis du logger ud, gemmes den aktuelle tilstand, og licensen frigives blandt de
tilgængelige pladser. Hvis du lukker softwaren ved hjælp af File > Exit eller
lukkeknappen , medfører det ikke, at en bruger automatisk bliver logget ud, og
licensen frigives.



Introduktion til TI-SmartView™-emulatorsoftware til
MathPrint™-lommeregnere
Med TI-SmartView™-emulatorsoftwaren til MathPrint™-lommeregnere kan du vise en
TI videnskabelig lommeregner til hele klassen.

Regnerens Emulator-vindue

Lader dig:

• Vælge emulator
– Vælg den emulator, du vil arbejde med.

– TI-30X Plus MathPrint™
– TI-30X Pro MathPrint™
– TI-30XS MultiView - TI-30XB MultiView™
– TI-34 MultiView™

• Skjule/vise stor emulatorvisning
– Vis Fuld emulatorvisning med eller uden et Stort

Skærmvisningspanel.
• Skjule/vise tastetrykhistorik

– Viser billeder af tastetryk, så elever kan følge med, når tasterne
trykkes.

• Starte et separat Skærmfangstvindue
– Indfang og gem emulatorskærme som computerfiler, ligesom ved TI

Connect™ CE-skærmfangst.

Se: Sådan bruges Emulator-vinduet til at forbedre dine præsentationer for klassen.
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5 Introduktion til TI-SmartView™-emulatorsoftware til MathPrint™-lommeregnere

Ibrugtagning: Valg af emulatortype

Første gang TI-SmartView™ til MathPrint™ startes på din computer, vises en
meddelelsesdialogboks.

Vælg emulatortypen ved hjælp af rullemenuen,
og vælg OK.
Den valgte emulator vises til din første
præsentation.

TI-SmartView™ til MathPrint™ genstartes altid i den seneste softwaretilstand. Fra
softwaren kan du ændre standardemulatoren.

Se: Sådan vælges en emulatortype.

Den seneste emulatortype i visningen bliver standard, og den seneste
tilpasning af vinduet vises i henhold til dine seneste indstillinger.

Se: Ændring af størrelsen på TI-SmartView™ Emulators store visningsskærm



Sådan bruges TI-SmartView™ Emulator-vinduet til
MathPrint™-lommeregnere
TI-SmartView™ Emulator-vinduet til MathPrint™-lommeregneren indeholder værktøjer,
du kan bruge til at indtaste beregninger .
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7 Sådan bruges TI-SmartView™ Emulator-vinduet til MathPrint™-lommeregnere

Dele af TI-SmartView™ Emulator-vinduet

Menulinje – Brug disse menuer til at udføre alle emulatorfunktioner, herunder:

• File (Fil) – luk eller afslut • Actions (Handlinger) – såsom
skærmfangst

• Edit (Rediger) – inklusive
kopier tast som skrifttype • Help (Hjælp) – Hjælp og links

• View (Vis) – skift
visningerne

Bemærk: Du kan fuldføre de fleste af handlingerne i disse menuer ved at klikke
på ikoner på værktøjslinjen.

Toolbar (Værktøjsbjælke) – Brug disse værktøjsbjælkeikoner til at:
• Vælge en anden regnermodel
• Skift mellem at skjule og vise Stor Visningsskærm, og slå Tastetrykhistorik

til eller fra
• Indfang aktuel emulatorskærm

Vælg Emulator- og Værktøjslinje-placeringer

• Emulator position Left/Right (Emulatorplacering Venstre/Højre) – til
at skifte mellem venstre- og højrehåndsvisning af lommeregnerens skærm.
Dette er bekvemt, når der projiceres på et interaktivt Whiteboard.

• Tool Bar Top/Bottom (Værktøjsbjælke Øverst/Nederst) – til at skifte
værktøjslinjen mellem øverst og nederst på skærmen. Dette er bekvemt, når
der projiceres på et interaktivt Whiteboard.

Bemærk: Du kan ændre det visuelle layout og/eller placering af elementer for at
optimere adgang, specielt ved brug af et interaktivt Whiteboard.

Emulator-panel – Brug dette panel til at vise den fulde emulator, eller kun
visning af emulator-tastaturet.

Stor Visningsskærm-panel/Tastetrykhistorik-panel – Brug dette panel til at vise
en stor version af regnerens skærm og/eller til at vise tastetrykhistorik.
Du har følgende visningsmuligheder:

• Kun Stor Visningsskærm • Kun Tastetrykhistorik
• Stor Visningsskærm +

Tastetrykhistorik • Skjul Stort Visningsskærm

Ændre størrelse på Paneler – Klik og træk på den lodrette bjælke på siden af



panelet for at ændre størrelsen.

Sådan bruges TI-SmartView™ Emulator-tastaturet
Musen overtager fingerens rolle med at trykke på computerens tastatur.

Klik på tasterne på TI-SmartView™ til MathPrint™-emulatoren, som du ville trykke på
tasterne på den videnskabelige lommeregner.

Du kan holde en piltast nede for at rulle markøren kontinuerligt.

Når du bruger en piltast til at flytte markøren, kan du holde tasten nede og rulle
kontinuerligt med markøren i stedet for at skulle trykke på tasten hele tiden. I
tastetrykhistorikken har ikonet for repeterende piltast et ursymbol tilføjet.

Ved at trykke på en piltast mange gange i træk vises en pil med en optælling af
gentagelserne.

Når du trykker på en piltast flere gange efter hinanden, vises en piltast i

tastetrykhistorikken; denne piltast har et tal vedhæftet, som viser antal gange der
blev trykket på den pågældende piltast.

Trække og slippe en skærm til en anden applikation
Du kan trække og slippe og indsætte enhver skærm i TI-SmartView™-emulatoren til
MathPrint™-lommeregnere til en anden applikation.

De skærme i TI-SmartView™-emulatoren til MathPrint™-lommeregnere, som kan
trækkes og indsættes, omfatter følgende:

• Skærmen over tastaturet i Emulatorpanelet.

• Stor Visningsskærm-panel

• Gemte eller ikke-gemte skærmfangster i Skærmfangstvinduet
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9 Sådan bruges TI-SmartView™ Emulator-vinduet til MathPrint™-lommeregnere

Nulstilling af emulatoren
Sådan nulstilles emulatoren:

1. Klik på Actions (Handlinger).

2. Klik på Reset Emulator (Nulstil emulator).

3. Klik på Reset (Nulstil).

Nulstilling af emulatoren:

• Overskriver den nuværende emulatortilstand

• Rydder tastetrykhistorik



Lagring og indlæsning af MathPrint™ Emulator Tilstand
Når du gemmer MathPrint™-emulatortilstanden, oprettes en fil, der gemmer
emulatorindstillingerne med alle de ændringer, du har foretaget.

Du kunne for eksempel ønske at opsætte en præsentation for en klasse ved at indtaste
data i en dataeditor og funktioner i f(x) og g(x). Hvis du har gemt ændringerne i en
emulatortilstandsfil, indlæser du blot filen for at vise præsentationen. Hvis du vil
oprette forskellige præsentationer til forskellige klasser, kan du oprette flere
emulatortilstandsfiler.

Bemærk: Tastetrykhistorikken, skærmfangstbillederne, emulatorvisningen og
emulatorstørrelsen gemmes ikke i emulatortilstandsfilen. Bemærk, at MathPrint™-
emulatortilstandsfilerne kan være store. Kontakt IT-afdelingen, hvis din lagerkapacitet
er et problem.

Lagring af MathPrint™-emulatortilstand

Styring, lagring og indlæsning af en emulatortilstandsfil er kun tilgængelig for
MathPrint™-emulatorer. TI-30X Pro MathPrint™-emulatortilstandsfilen kan kun
indlæses på TI-30X Pro MathPrint™-emulatoren.

Bemærk: TI-30X Plus MathPrint™-emulatortilstandsfilen kan kun indlæses på TI-30X
Plus MathPrint™-emulatoren.

1. Klik på Actions (Handlinger) > Save Emulator State... (Gem emulatortilstand)....

2. I dialogboksen:

a) Naviger til den mappe, hvor du vil gemme MathPrint™-emulatortilstandsfilen.
b) Skriv et filnavn. Brug et navn, der beskriver MathPrint™-emulatortilstanden.
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11 Sådan bruges TI-SmartView™ Emulator-vinduet til MathPrint™-lommeregnere

Bemærk: MathPrint™-emulatortilstandsfiler har et forudkonfigureret filnavn
med filtypenavnet *.s3l, som angiver den TI-30X Plus MathPrint™-
lommeregner-emulatortilstand, der oprettes af TI-SmartView™MathPrint™-
emulatorsoftwaren. Filtypenavnet for TI-30X Pro MathPrint™-lommeregner-
emulatortilstanden er *.s3r.

c) Klik på Save (Gem).

Indlæsning af en MathPrint™-emulatortilstand

Da MathPrint™-emulatortilstandsfilerne er specifikke for hver lommeregnermodel, kan
der kun indlæses en emulatortilstandsfil for den aktive model.

1. Klik på Actions (Handlinger) > Load Emulator State (Indlæs emulatortilstand).

2. I dialogboksen:

a) Naviger til den mappe, der indeholder emulatortilstandsfilen.

Bemærk: Kun MathPrint™-emulatortilstandsfilerne for den aktive
lommeregnermodel vises.

b) Klik på MathPrint™-emulatortilstandens navn for at fremhæve det.
c) Klik på Open (Åbn).



Sådan vælges en visningsindstilling
Du kan tilpasse din skærm til at vise eller skjule valgfrie paneler eller ændre de
informationstyper, der vises i hvert panel. Som standard viser TI-SmartView™-
emulatorsoftwaren til MathPrint™-lommeregnere Emulator-vindue til lommeregneren
på Stor Visningsskærm.

Sådan vises regnerskærmen

1. Klik på for at
skjule det store
skærmvisningsskærm-
panel.

2. Klik på igen for at
vise det store skærmvisningsskærm-panel.

Sådan vælges en emulatortype

Klik på ned-pilen på for at vælge en emulatortype.

Hver emulatortype viser dens relevante regnermodel.

Sådan bruges TI-SmartView™ Emulator-vinduet til MathPrint™-lommeregnere 12



13 Sådan bruges TI-SmartView™ Emulator-vinduet til MathPrint™-lommeregnere

Sådan ændres regnerens forplade

Sådan skifter du forpladen:

1. Klik på View (Vis).

2. Hold markøren over regnerens forplade.

3. Klik på et navn på en regnerforplade.

Lys Mørk Kontur

Vise eller skjule Tastetrykhistorikken

Klik på for at vise eller skjule tastetrykhistorik.
Klik på CLEAR (RYD) i panelet ved siden af Tastetrykhistorik for at rydde historikken.

Klik her, og træk for
at ændre størrelsen
på Tastetrykhistorik-
panelet.

Klik her, når du
har valgt taster,
for at kopiere
skrifttype som
grafik.

Klik her for at rydde
Tastetrykhistorik.



Når du trykker ryd, vil du se denne informationskasse:

Kopiering af tastetrykhistorik til en anden applikation
Du kan kopiere alle eller kun en markeret del af tastetrykhistorikken til en anden

applikation som et tekstbehandlingsprogram. Du kan kopiere tastegrafikken ,
som den vises i tastetrykhistorikpanelet, eller du kan kopiere tastetrykkene som
skrifttypeteksttegnene5U6.

Bemærk: Når du kopierer taster som teksttegn i en skrifttype, anvender de pågældende
tegn skrifttypen TI-30X Pro Key. Kun skrifttyper for primære taster indsættes. Skrifttyper
for sekundære taster kan ikke indsættes fra funktionen til kopiering som skrifttype i TI-
SmartView™. Du kan indsætte sekundære funktioner manuelt ved hjælp af den
installerede skrifttype. Denne skrifttype installeres automatisk på computeren, når du
installerer softwaren TI- SmartView™ til MathPrint™-lommeregnere. Skrifttypen har
alle TI-30X Plus-tastskrifttyper som undersæt til TI-30X Pro-tastskrifttyper.

Sådan kopieres taster som grafik eller teksttegn i en skrifttype

1. Marker tasten(erne), du vil kopiere.
For at vælge taster i Tastetrykhistorik-panelet, bruges en af følgende metoder:

Tast Metode
– En enkelt tast: Klik på en tast.

– Flere taster: Klik på en tast.
Tryk og hold Ctrl på din computers
tastatur.
Klik på andre taster for at vælge flere
taster.

– Flere taster i en sekvens: Klik på en tast.
Tryk og hold Shift på din computers
tastatur.
Tryk på en anden tast.
Bemærk: Dette giver dig mulighed for
at vælge disse to taster, plus alle
tasterne mellem dem.

– Alle taster: Kilk på en tast.
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15 Sådan bruges TI-SmartView™ Emulator-vinduet til MathPrint™-lommeregnere

Tast Metode
Højreklik.
Klik Vælg alt.

Bemærk: Sådan ser en tast ud, før og efter du vælger den.

Før: Efter:

2. Vælg taster

3. Klik på Edit (Rediger) > Copy (Kopier) (for at kopiere taster som grafik).

eller

Klik på Edit (Rediger) > Copy As Font (Kopier som skrifttype) (for at kopiere taster
som skrifttypetegn)5U6.

4. Skift til en anden applikation.

5. Indsæt tasterne på den korrekte plads.

Bemærk:

• Du kan også trække de markerede taster til den nye applikation som grafik.

• Du kan også ændre størrelsen på tastegrafikken, efter du har indsat dem i en ny
applikation.

• I visse applikationer kan de indsatte tegn blive vist som den skrifttype, der er
aktiveret på det pågældende sted, så de overhovedet ikke ligner taster på en
videnskabelig lommeregner. Anvend om nødvendigt skrifttypen TI-30X Pro Key på
tegnene. Se hjælpefilen til den destinationsapplikation du benytter for at få
oplysninger om, hvordan en skrifttype anvendes på tegnene.



Ændring af størrelsen på TI-SmartView™ Emulators store
visningsskærm
Klik på og træk i kanten af Stor Visningsskærm-panelet for at ændre størrelsen.

Bemærk: Alle disse er venstre/højre-handlinger, undtagen Tastetrykhistorik, som er
træk op eller ned for at ændre størrelse.

Placering af Emulator og Værktøjslinjer
Emulator position Left/Right (Emulatorplacering Venstre/Højre) – til at
skifte mellem venstre- og højrehåndsvisning af den videnskabelige
lommeregners skærm. Dette er bekvemt, når der projiceres på et
interaktivt Whiteboard.

Tool Bar Top/Bottom (Værktøjsbjælke Øverst/Nederst) – til at skifte
værktøjslinjen mellem øverst og nederst på skærmen. Dette er bekvemt,
når der projiceres på et interaktivt Whiteboard.
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17 Sådan bruges TI-SmartView™ Emulator-vinduet til MathPrint™-lommeregnere

Altid forrest
Vælg denne mulighed i Visningsmenuen for at holde vinduerne for TI-SmartView™-
emulatoren til MathPrint™-regnere foran ethvert andet åbent
computersoftwarevindue. Svarende til at have regneren liggende på dit skrivebord,
oven på dine papirer! Placér vinduet på din computers skrivebord, hvor det ligger bedst
som "Altid forrest."

Deaktivér "Altid forrest," fravælg menuemnet i Visningsmenuen. Der er ikke noget
værktøjslinjeikon til denne funktion, og ingen anden indikator end krydset i menuen når
den er aktiv.

Noter:

Vinduet for TI-SmartView™-emulatoren til MathPrint™-lommeregnere og
Skærmfangstvinduet vil begge være "Altid forrest" og skifte til forrest afhængigt af
deres placering.

"Altid forrest." anbefales ikke ved fuld skærm, da alle andre vinduer vil være bag TI-
SmartView™-emulatoren til MathPrint™-lommeregnere.



Sådan bruges skærmfangst
Du kan indfange den aktuelle specifikke lommeregnerskærm ved hjælp af
skærmfangerværktøjet i TI-SmartView™-emulatoren til MathPrint™-lommeregnere.

Sådan bruges skærmfangst:

▶ Klik på på værktøjslinjen.

Dette vindue vises:
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19 Sådan bruges skærmfangst

Dele af Skærmfangstvinduet

Fangst Klik her for at tage en emulator-skærmfangst.
Actions (Handlinger) > Capture Screen (Indfang skærm)
Bemærk: Der bliver automatisk føjet en ramme til hvert
billede, når du indfanger det, men du kan fjerne rammen ved
at klikke på View (Vis) > Hide Screen Capture Borders (Skjul
Skærmfangstrammer). (Hvis du har flere billeder, fjerner dette
rammen fra hvert billede).
Med skærmfangst kan du:
• indfange op til 44 skærme ad gangen, (for at indfange

yderligere billeder, slet billeder fra Skærmfangsvinduet)
• automatisk gemme skærmfangster i hukommelsen, indtil

du lukker det primære vindue i TI-SmartView™ til
MathPrint™-lommeregnere.

At lukke Skærmfangster udløser en prompt om at gemme
dine skærmfangster. Du kan starte en ny Skærmfangstsession
under en session i TI-SmartView™ til MathPrint™-
lommeregnere.

Save (Gem) Klik her for at gemme udvalgte skærmfangster.
File (Fil) > Save As (Gem som)

Copy (Kopier) Klik her for at kopiere udvalgte skærmfangster til
udklipsholderen.
Edit (Rediger) > Copy (Kopier)

Delete (Slet) Klik her for at slette udvalgte skærmfangster.
Edit (Rediger) > Delete (Slet)

Resize (Tilpas
størrelse)

Forskyd prikken langs med bjælken, for at justere størrelsen
på den nuværende skærmfangsts forhåndsvisning.
View (Vis) > Scale Screen Captures (Skaler Skærmfangster)
Bemærk: Skærme gemmer procentdelen i visningen.

Rename
(Omdøb)

Omdøb skærmfangsten ved at markere titlen og taste et nyt
navn

View (Vis) Vis skærmfangster her.

Trække og slippe en skærm til en anden applikation
Du kan trække og slippe og indsætte enhver skærm i TI-SmartView™-emulatoren til
MathPrint™-lommeregnere til en anden applikation.

De skærme i TI-SmartView™-emulatoren til MathPrint™-lommeregnere, som kan
trækkes og indsættes, omfatter følgende:

• Skærmen over tastaturet i Emulatorpanelet.

• Stor Visningsskærm-panel

• Gemte eller ikke-gemte skærmfangster i Skærmfangstvinduet



Tastaturtilknytning
Du kan bruge dit computertastatur til at trykke på en tast i stedet for at trykke på den
pågældende tast på TI-SmartView™-emulatorens tastaturbillede.

Anvendelse af computerens tastatur
Hvis du vil trykke på en emulatortast ved hjælp af computerens tastatur, skal du bruge
tabellen herunder for at se, hvilken tastaturtast der er knyttet til emulatortasten.

• TI-30X Pro MathPrint™ or TI-30X Plus MathPrint™ tastaturgenveje

• TI-30XS-30XB MultiView™ tastaturgenveje

• TI-34 MultiView™ tastaturgenveje

Tastaturtilknytning 20



21 Tastaturtilknytning

TI-30X Pro MathPrint™ or TI-30X Plus MathPrint™

Eksempel: Tryk på [W] på computerens tastatur som vist i tabellen herunder for at få
vist tilstandsskærmen.

TI-30X Pro MathPrint™ tastaturgenveje:

TI-30X Plus MathPrint™ tastaturgenveje:



*Bemærk:

På MAC-computerens tastatur:

- Tryk på [Slet] forJ.
- Tryk på [Tilbage] for-.
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23 Tastaturtilknytning

TI-30XS/30XB MultiView™

Eksempel: Tryk på [W] på computerens tastatur som vist i tabellen herunder for at få
vist tilstandsskærmen.

Bemærk: Undtagelse på MAC



*Bemærk:

På MAC-computerens tastatur:

- Tryk på [Slet] forJ.
- Tryk på [Tilbage] for-.
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25 Tastaturtilknytning

TI-34 MultiView™

Eksempel: Tryk på [W] på computerens tastatur som vist i tabellen herunder for at få
vist tilstandsskærmen.

Bemærk: Undtagelse på MAC



*Bemærk:

På MAC-computerens tastatur:

- Tryk på [Slet] forJ.
- Tryk på [Tilbage] for-.
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27 Generelle oplysninger

Generelle oplysninger
Online hjælp
education.ti.com/eguide

Vælg dit land for at få flere produktoplysninger.

Kontakt TI Support
education.ti.com/ti-cares

Vælg dit land for at finde ressourcer for teknisk support og andre supportressourcer.

Service og garanti
education.ti.com/warranty

Vælg dit land for at få oplysninger om varigheden og betingelserne for garantien, eller
om produktservice.

Begrænset reklamationsret. Denne garanti påvirker ikke dine lovbestemte rettigheder.

https://education.ti.com/eguide
https://education.ti.com/ti-cares
https://education.ti.com/warranty
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